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Abstract 

Analysis of Variance (ANOVA) is an important topic in introductory statistics. Many students struggle to 

understand the ANOVA concepts. In this paper, we describe how to use resampling with Excel Data Tables and 

standard functions to perform one-way ANOVA. We calculate different values of the F-statistic by resampling from 

the original sample and compute the p-value of the test. Using this approach, students will be able to get a better 

feel about the p-value concept. Our preliminary assessment shows that students have better feeling about this 

approach. 

 

1. Introduction 

Statistics is important not only in research but also in everyday usage. Statistical knowledge is 

relevant in many areas such as social science, natural science, engineering, and business. 

Therefore, students are required to take at least one course in statistics in many college degree 

programs.  Understanding of statistical concepts such as sampling distributions, confidence 

intervals, hypothesis testing, and p-values is not easy for many students and many educators are 

conducting research on the teaching and learning of these concepts [2,10,15]. Computers have 

had a tremendous impact on teaching statistics at any level. Tishkovskaya et al. [16] have shown 

that the teaching and learning of statistics has benefited from the development of technological 

resources. The traditional way of teaching using books, lectures, and mathematical derivations 

does not give a good understanding of the concepts to many students at the introductory level. 

Some statistics instructors have been using computer simulation methods (CSM) in the 

classroom to teach difficult concepts. Computer simulation methods allow students to 

experiment with random samples for the purpose of clarifying abstract and difficult concepts of 

statistics. Cobb [5] noted that incorporating computer simulation to illustrate the key concepts 

and to allow students to discover important principles themselves enhances their knowledge.  

delMas et al. [6] evaluated the benefits of the computer simulation where students drew multiple 

samples from a variety of populations in order to observe the sampling distribution of the mean. 

Their evaluation of the simulation suggests that it provided an effective supplement to book and 

lecture-based methods of instruction. Johnson [9] used Minitab macros to resample in hypothesis 

testing. In his work, he pointed out that minimal or no mathematical skills are required and that 

the resampling approach helps students in understanding the statistical concepts. Black [1] was 

one of the first authors to recognize the usefulness of spreadsheets in a simulation context for 

teaching complex concepts of statistics. He used spreadsheet simulation to calculate the power of 
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the tests as a planning tool. Hagtvedt et al. [7, 8] have developed a Visual Basic Application 

(VBA) tool that is integrated into Excel spreadsheets to simulate sampling distributions and 

confidence intervals. Their assessment showed that the students who used their applications did 

significantly better than the students who did not use VBA based simulation. A comprehensive 

review of the literature of computer simulation methods used in all areas of statistics to help 

students understand difficult concepts has been done by Mills [11]. The results of the study of 

Mills [12] indicated some evidence that the computer simulation methods improve student 

understanding of abstract statistical concepts in introductory classes. 

There are many on-line sources that allow students to simulate random variables and test 

statistics and to visualize their distributional properties. However, almost without exception, 

these on-line sources either build their simulation application using something other than a 

simple spreadsheet, or may not provide the source code. These web-based applications are 

written in languages such as Java, JavaScript, or some other programming languages, and their 

usefulness to introductory level students who are majoring in social science is somewhat 

questionable. Generally, introductory statistics students do not have the necessary skills to 

produce codes that would replicate what can be found in these on-line sites. Furthermore, web-

based applications require an internet connection to be used in the classroom or anywhere else. 

An Excel demonstration can be used with or without an internet connection. As long as the 

students have access to a computer with Excel, they can perform these simulations and visualize 

the intended concepts.  

In this paper, we describe how to use Excel standard formulas and the Data Table function to 

perform simulation using resampling in teaching one-way analysis of variance (ANOVA). 

ANOVA is one of many important topics in the introductory statistics curriculum. ANOVA is 

commonly used in many areas to compare means of several populations.  The Rossman/Chance 

Applet Collection [14] includes a Java applet that simulates the ANOVA table for given sample 

sizes. Combination of Excel standard functions and Data Tables provides a convenient way to 

conduct simulation and resampling. Chandrakantha [3] used Excel Data Tables in teaching 

confidence intervals and hypothesis testing in introductory statistics classes. Christie [4] provides 

a way to used Excel Data Tables for estimating the population mean and the correlation. 

This paper is organized as follows. In section 2, we give a brief overview of one-way ANOVA 

and an example. In section 3, the Data Tables and the resampling process of simulating ANOVA 

is introduced.  In section 4, p-value calculations and the empirical distribution of the F-statistic 

are presented. In sections 5 and 6, a comparison of two teaching methods and concluding 

remarks are given. 

2. Overview of ANOVA 

The one-way analysis of variance procedure, referred to as ANOVA, is used to test the following 

hypothesis: the means of two or more populations are the same against the alternative that not all 
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population means are the same. The validity of the ANOVA test for equality of means requires 

following assumptions. The populations from which samples are drawn have the same variance, 

σ
2
. It also requires that each of the samples is obtained from a population with a normal 

distribution and each sample is randomly selected and is independent of all other samples.  

The ANOVA test is performed by calculating two estimates of the variance, σ
2
, of the population 

distributions: the variance between samples and the variance within samples. The variance 

between samples is also known as mean square between samples (MSB) and the variance within 

samples is also known as mean square within samples (MSW or MSE). We will use the notation 

MSB and MSW here. Both MSB and MSW estimate the variance of populations, σ
2
. MSB is 

based on the values of the means of the samples taken from populations and MSW is based on 

the individual values in the samples. If the means of the populations under consideration are not 

equal, the variation among the means of respective samples is expected to be large, and, 

therefore, the value of MSB is expected to be large. Both MSB and MSW are obtained using 

sum of squares and hence each associates the degrees of freedom. Let’s assume k is the number 

of populations under consideration and n is the number of data values in all samples. MSB 

measures the variation of the k sample means around the overall mean, and then its degrees 

freedom are k - 1. MSW measures the variation within k samples of n observations all together 

and its degrees of freedom are n - k.  

The value of the F-statistic for the ANOVA test is calculated as 

MSW

MSB

sampleswithinVariance

samplesbetweenVariance
F  . 

This test statistic is assumed to be an F-statistic with degrees of freedom k - 1 and n - k 

respectively. The formulas for calculating MSB and MSW can be found in any introductory 

statistics text. The one-way ANOVA test is always right-tailed and the p-value is computed 

using the right tail of the F distribution curve.   

Example: The following example is used to demonstrate the simulation of ANOVA test to the 

class.  A university employment office wants to compare the amount of time taken by graduates 

with three different majors to find their first full time job after graduation. Table 2.1 lists the 

times (in days) for random samples of business, computer science, and engineering majors who 

graduated recently.  

Business 208 162 240 180 148 312 176  292 

Computer Science 136 113 281 128 305 147 232  

Engineering 126 275 363 146 298 392   

Table 2.1: Sample of times (in days) 

Can we conclude that the mean time taken to find their first full time job for all graduates in 

these fields is the same? 
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The null and alternative hypotheses are defined as follows. In this example, we compare the 

mean time taken to find their first job for graduates in the three populations: Business, Computer 

Science, and Engineering. We assume the notation, µi represents the mean time taken to find the 

first job for the population i.  

H0: µ1 = µ2 = µ3.   This means all population means are the same. 

H1: Not all population means are the same. 

Under the null hypothesis, the data comes from populations with the same mean and we are 

interested in how often the value of the test statistic is as large as the one we observe will occur 

by chance if, in fact, this hypothesis is true.  

Now we show how to solve this problem traditionally.  First, we verify the validity of the 

assumptions. Following Peck et al. [13], if sample sizes are so small, a separate boxplot for each 

sample is of little value in checking normality. In this case, a single combined plot can be 

constructed by first subtracting the sample mean from each value in the corresponding sample, 

and then constructing a normal probability or box plot for all n deviations from their respective 

means. The boxplot should be reasonably symmetric. Figure 2.1 shows the combined boxplot for 

our example. This boxplot is roughly symmetric, and there are no outliers. For identical variance 

assumption, the ANOVA test can safely be used if the largest of the sample standard deviations 

is at most twice the smallest one. The largest standard deviation in our example is 109.90, which 

is only about 1.8 times the smallest standard deviation, 61.01. We can assume that each sample is 

randomly selected and is independent of others. The assumptions of ANOVA are reasonable. 

 
Figure 2.1: Boxplot of deviations from means 

The F-statistic is given by the ratio of the variance between samples (MSB) and the variance 

within samples (MSW). The value of MSB is calculated by dividing the sum of squares between 

samples (SSB) by degrees of freedom between samples which are k – 1. The following formula 

is used to calculate MSB: 



 The Electronic Journal of Mathematics and Technology, Volume 9, Number 4, ISSN 1933-2823  

 

285 
 

11

2

3

2

3

2

2

2

1

2

1

















k

n

T

n

T

n

T

n

T

k

SSB
MSB  

where Ti is the sum of the values in the sample from i
th

 population and T is the sum of the values 

in all samples. ni is the number values in the sample from i
th

 population and n is the number of 

values in all samples. 

The value of MSW is calculated by dividing the sum of squares within samples (SSW) by 

degrees of freedom within samples which are n - k. The following formula is used to calculate 

MSW: 
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where 
2

ToT
x  is the sum of all data squares.  

For our example, T1 = 1718, T2 = 1362, T3 = 1600, T = 4680, 
2

ToT
x = 1182958, n1 = 8, n2 = 7, 

n3 = 6, n = 21, and k = 3.  Substituting these values into above two formulas, we get MSB = 

8821.01 and MSW = 6796.92. Then the value of the F-statistic is 8821.01/6796.92 = 1.2978. To 

find the approximate p-value for this F-statistic value, we use the F distribution table for F 

distribution with 2 and 18 degrees of freedom.  The approximate p-value is larger than 0.10. This 

larger p-value allows us to conclude that the means of the three populations are the same. In the 

next section, we compute the value of the F-statistic for different resamples using Data Tables 

and the corresponding p-value. The visual display of the sampling distribution of the test statistic 

using simulation will help students to grasp the concept of the p-value. 

 

3. Simulation Using Excel Data Tables 

3.1  Data Table Introduction 

Data Tables are part of a group of commands that are called the what-if analysis tools in Excel. 

When you use Data Tables, you are doing a what-if analysis. What-if analysis is the process of 

changing the values in cells to see how those changes will affect the outcome of formulas on the 

worksheet. We can use the Data Table function to compute the values of a test statistic for 

different random samples of data.  The Data Table function is available in all Excel versions. 
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For example, a company’s projected profit may depend on number of units sold and some other 

factors. We can set up a spreadsheet using Data Tables to calculate the projected profit for 

different values of number of units sold. Figure 3.1 shows a simple Data Table setup.  

The original input is the number of units sold in cell D2. The original output is the profit in cell 

D9 which is calculated based on the original input. The various possible values of input are put 

in the left column of the Data Table. The formula containing the original profit in cell D9 is put 

at the top of the second column of the Data Table. We select the cell range F3:G13 and select 

Data > What IF Analysis > Data Tables. This opens the Data Table Dialog Box shown in the 

Figure 3.1. We leave the Row input cell blank and put the original input’s cell reference, D2, for 

the Column input cell. Once we click OK, the Data Table tool runs down the left hand column of 

the table, substituting the value in that column into the original column input cell in D2. The 

formula at the top right column of the table is evaluated for each substitution of the input cell 

value to compute the profit values in the right column. This way is more convenient than 

changing the input (units sold) manually and recoding the profit for each input in a table.  

To generate the values of a statistic for different samples using the Data Table, first we calculate 

the value of the statistic based on a random sample. This will be our original output value. Now 

we set up our Data Table by putting this value (formula for this output value) in the top cell of 

the right column. We leave the left column blank and select the table and access the Data Table 

dialog box using menu bar Data > What If Analysis > Data Tables.  For the column input cell in 

the Data Table dialog box, we type an empty cell reference that has no part in this Data Table set 

up. Excel generates a new sample and computes the value of the statistic for each substitution of 

Figure 3.1: Data Table Setup 
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this empty input cell and fills the table. Copying the formula down of the output cell does not 

work in this case. If we do this manually, we need to recalculate the statistic by repeated 

sampling by pressing F9 key and recording these values in the column. The Data Table function 

recalculates the values whenever we change the spreadsheet. Some times this may slow down the 

speed of the work. This can be avoided by turning off the calculation by using the menu bar 

File> Options > Formulas > Automatic except for data tables > OK. We can recalculate the table 

again by pressing the F9 key.  

3.2 Spreadsheet Implementation of the Example 

In this section, we show how to resample, without replacement, from given data, generate 1000 

resamples, and calculate the F-statistic values assuming data come from a single population. 

Figure 3.2 shows the spreadsheet implementation of this example. We separate our data into 

three sets at random and calculate the value of the test statistic. This value is recorded in the Data 

Table in Figure 3.2. 

First, we put the data in a single column with the three groups going from B3:B10 (Business 

majors), B11:B17 (Computer Science majors), and B18:B23 (Engineering majors). Under the 

null hypothesis, times for all three majors are drawn from populations with the same mean and 

the same standard deviation, and it will not matter how they are allocated among groups. Column 

D contains simple random numbers generated from the RAND function. To generate these 

random numbers, we write the formula = RAND() in cell D3 and copy this formula to cells D4 

through D23. Column E finds the rank order of these random numbers using the RANK function 

to produce an ordering to resample from the original data in B3:B23. This is done by writing the 

formula = RANK(D3,$D$3:$D$23) in cell E3 and copying this formula to cells E4 through E23.  

Now the VLOOKUP function and the random ordering created in column E are used to generate 

three samples from the data in B3:B23 and display these resampled values in F3:F23. This is 

done by writing the formula = VLOOKUP(E3,$A$3:$B$23,2) in cell F3 and copying this 

formula to cells F4 through F23. Sum of the data values for three groups are calculated in cells 

B25:B27 and F25:F27 for the original data and resampled data respectively. In cells B28:B29 

and F28:F29, we calculate the sum of the data values and the sum of the squares of data values 

for entire sample for the original and resampled data. Cells B30:B31 and F30:F31 give the sum 

of squares between groups (SSB) and the sum of the squares within groups (SSW). Finally, we 

calculate the value of the F-statistic for the original data and the resampled values in cells B32 

and F32 respectively. 

The values of the resampled test statistic are calculated using the Data Table. The Data Table 

goes down as far as you want, but in this work, we create 1000 values. Figure 3.2 shows only a 

portion of the spreadsheet of this implementation. Our Data Table has the cell range H2 to I1001 

which calculates 1000 values of the statistic. The top right cell I2 of the table contains the 

formula = F32. The left column of the table is left blank. We select the cell range H2:I1001, and 

use the commands Data > What-if Analysis > Data Table. In the Data Table dialog box, leave 
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Row input cell blank and select any empty cell (say J1) for Column input cell and click OK. This 

will fill the right column with 1000 values of the statistic for repeated resamples. Pressing the F9 

key will recalculate a different set of values of the statistic. Since students are doing these steps 

themselves, they visualize each step and get a clear understanding of the resampling process. 

Table 3.1 shows the summary of the Excel formulas written in the spreadsheet implementation in 

Figure 3.2. 

Cell Formula Purpose 

D3 =RAND( ) To generate simple random numbers. 
E3 =RANK(D3,$D$3:$D$23) To create a rank ordering in values in column D. 

F3 =VLOOKUP(E3,$A$3:$B$23,2) To resample the values in column B. 

B25 =SUM(B3:B10) To compute the sum of the values for Business 

majors. 

B26 =SUM(B11:B17)   To compute the sum of the values for Computer 

Science majors 

B27 =SUM(B18:B23) To compute the sum of the values for Engineering 

majors 

B28 =SUM(B3:B23) To compute the sum of the values in the sample. 

B29 = SUMPRODUCT(B3:B23,B3:B23) To compute the sum of the squares of the values in 

the sample 

B30 =POWER(B25,2)/8+POWER(B26,2)/7+POWER

(B27,2)/6 - POWER(B28,2)/21 

To compute the sum of squares between groups 

(SSB). 

B31 =B29-(POWER(B25,2)/8 + POWER(B26,2)/7 + 

POWER(B27,2)/6) 

To compute the sum of squares within groups 

(SSW). 

B32 =(B30/2)/(B31/18) To compute the value of the F- statistic. 

I2 =F32 Top cell of the Data Table. Use this value to 

compute the Data Table 

L3 =(COUNTIF(I2:I1001,">=1.297796"))/1000 To compute the p-value. This will count how many 

cells in range I2:I1001 are greater than or equal to 

1.297796 and divide this count by 1000 to find the 

proportion 

Table 3.1: Excel formulas 
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Figure 3.2: Portion of the spreadsheet showing simulated values of the statistic and the p-value 

 

4. P-Value and Empirical Distribution  

In order to evaluate whether a value of the test statistic as large as the one from the observed 

sample is likely, we simply compute the proportion of the 1000 resamples where the tests 

statistic values given in the Data Table exceed the observed value which is calculated in cell 

B32. This is known as the approximate p-value of the test and it is the proportion of values of the 

test statistic, assuming data come from populations with same mean, that are as extreme or more 

extreme than the observed value of the test statistic. This is calculated in cell L3 in Figure 3.2 

using the formula = (COUNTIF(I2:I1001, ">=1.297796"))/1000 as 0.297. The theoretical p-

value based on the F distribution with 2 and 18 degrees of freedom can be calculated using the 

Excel formula = F.DIST.RT(1.297796,2,18,) and it is 0.2975. This value agrees with our 

simulated value up to three decimal places. Interpreting this p-value, we can say that it is fairly 

likely one would observe a value of the statistic as large as, or larger than the one produced 

assuming there is no difference in the population averages of the times to find their first full time 

job for graduates of the three majors under consideration. This relatively larger p-value provides 
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no sufficient evidence against the claim that “the mean time taken to find their first full time job 

for all graduates in these fields is the same”. 

We want to point out that if we run another simulation of 1000 resamples, we get a slightly 

different p-value in the cell L3. We can generate a new set of resamples by pressing F9 key. The 

following p-values were given for ten simulations: 0.296, 0.297, 0.278, 0.285, 0.282, 0.281, 

0.306, 0.301, 0.302, and 0.284.  

The Excel histogram in Figure 4.1 shows the empirical distribution of the test statistic for 1000 

resamples. The shaded area represents the number of values exceeding the observed value of the 

statistic.  The pdf curve of the F distribution with 2 ad 18 degrees of freedom is overlaid on 

histogram. The histogram of values of the statistic suggests that they are closely modeled with an 

F distribution with 2 and 18 degrees of freedom. This confirms that we can use the resampling 

approach to perform the ANOVA test. 

 
Figure 4.1: Histogram of the values of the F-test statistic 

 

5. Comparison of Two Methods 

We taught two introductory statistics sections in fall 2014, one using CSM approach with Excel 

described in this paper and the other by the traditional method of not using simulation. Both 

classes have the same instructor, same course content, same exams, same quizzes, and same 

assignments. Both classes were met on Mondays and Wednesdays evening schedule. The CSM 

class size was 28 and traditional method class size was 25. At the end of the lesson, the following 

survey was conducted to get an idea about students’ attitudes about the method of teaching. Each 

question has three answering options, namely yes, no, and no opinion. 
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Q1. Method helps me to understand the concepts. 

Q2. Feeling like I am part of the discussion. 

Q3. Feeling comfortable taking part in the lesson. 

Q4. Visual representation of outcomes is useful in understanding. 

Q5. Recommend this approach to other students. 

 

Table 5.1 gives the summary of their responses: 

 CSM Method Class Traditional Method Class 

Question Yes No No Opinion Yes No No Opinion 

Q1 56% 24% 20% 39% 35% 26% 

Q2 68% 20% 12% 35% 43% 22% 

Q3 64% 24% 12% 57% 17% 26% 

Q4 60% 24% 16% 57% 13% 30% 

Q5 64% 16% 20% 52% 35% 13% 

Table 5.1: Summary of students' responses 

Question p-value 

Q1 0.106 

Q2 0.010 

Q3 0.269 

Q4 0.364 

Q5 0.182 

Table 5.2: p-values 

The majority of the students in the CSM class answered yes to all five questions while majority 

of traditional method class students answered yes to only questions 3, 4, and 5. Looking at the 

percentages, we observe that students are understanding concepts better and feeling more 

comfortable in computer simulation approach. To get a clear understanding about the 

percentages, we performed z-tests for comparison of proportions of students who answered yes 

in both teaching methods for each question. Excel does not have a specific function for 

comparison of two proportions. We used Excel to calculate the test statistic and p-value for z-test 

in each case. At 5% significance level, we tested the claim that the proportion of students who 

answered yes in CSM method was greater than the corresponding proportion in other group. The 

requirement of expected number of successes and failures in comparison of proportions is also 

met for all cases. The Table 5.2 gives the p-value for each case. Looking at the p-values, only for 

question two (feeling like I am part of the discussion), the proportion of students answered yes in 

CSM class is significantly greater than the corresponding proportion in the other class.  
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The quiz given in the Appendix was given to both classes after completing the ANOVA chapter. 

The points scale for the quiz was 0 to 100. The Table 5.3 gives the quiz scores statistics. A dot 

plot for these quiz scores were created using Excel and is shown in Figure 5.1.  

Class n Mean Median Std. Dev. 

CSM class 28 76.85 78 14.41 

Traditional method class 25 69.96 70 14.37 

 Table 5.3: Quiz score statistics 

 
Figure 5.1: Dot Plot of quiz grades 

The two sample t-test performed on quiz scores using Excel to test the hypothesis that the CSM 

method class performs better on average than the traditional method class. The p-value produced 

by Excel was 0.0438. This p-value indicates that CSM method class performs better at 0.05 

significance level. We have to caution that these sample sizes for the survey and assessment 

statistics are not large enough to make a firm judgment on the conclusion. We plan to use larger 

sample sizes in the future in order to give a comprehensive survey and to make a formal 

assessment.  

                 

6. Conclusion 

Until recent years, many statistics instructors used the traditional way of teaching which 

concentrated on the derivation of the test statistics whose sampling distribution can be derived 

mathematically. These mathematical derivations require skills beyond most students in 

introductory statistics classes. In contrast, the computer simulation approach described in this 

paper requires no mathematical skills and leads students to better understanding of the concepts. 

We have demonstrated how to teach ANOVA concepts using simulation. This approach of using 

Excel Data Tables and formulas is relatively easy for students to comprehend the concepts by 

implementing in a spreadsheet and visualizing the sampling distributions and p-values.  Excel is 

easy to use software and many students have access to it. Our preliminary assessment suggests 

that computer simulation approach will enhance students’ understanding of concepts and 

majority of students feel more comfortable using this approach. With the advancement of 
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technology, we can now use computer intensive methods either as an alternative to, or preferably 

in support of, traditional methods of teaching statistics.  
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Appendix 

STA 250: ANOVA Quiz       

 

1. Of the values for an ANOVA test statistic listed below, which one is likely to lead to rejecting 

the null hypothesis in a test for equal means? 

A) 0.78 B) 2.02  C) 1.94  D) 45.1 

 

2. When hypothesis testing involves more than two means, we use the ANOVA rather than the t-

test. ANOVA stands for: 

A) variation between the levels. 

B) analysis of variances. 

C) the estimation of the ratio of two population variances. 

D) an optional variance analysis. 

3. In one-way ANOVA, if the test is conducted and the null hypothesis is rejected, what does 

this indicate? 

A) All the population means are equal. 

B) At least one of the population means is different from others. 

C) The normal distribution should be used instead of the F-distribution to determine the 

critical value for the test. 

D) None of the above. 

 

4. Which of the following statements is false regarding a one-way ANOVA? 

A) Between-sample variation and within-sample variation are compared in ANOVA. 

B) SST = SSB + SSW. 

C) F-ratio = MSB/MSW. 

D) None of the above. 

 

5.  In one-way ANOVA, the p-value is 

 A)  the probability, assuming all means are the same, that the F- statistic will take a value at 

least as extreme as that actually observed. 

http://www.rossmanchance.com/applets/
http://www.amstat.org/publications/jse/v20n2/tishkovskaya.pdf
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 B)  the probability, assuming means are different, that the F- statistic will take a value at least 

as extreme as that actually observed. 

 C)  the probability that all means are the same. 

 D)  the probability that means are different. 

 

6.  A researcher reports an F-statistic with df = 2, 40 from one-way ANOVA. How many 

treatment conditions were compared in this experiment? 

 A) 2  B) 3      C) 4  D) 41 

 

7.  When conducting one-way ANOVA, the _________ the between sample variability is when 

compared to the within sample variability, the  _________  the value of the F-statistic tend to 

be. 

 A)  smaller, larger 

 B)  larger, smaller 

 C)  larger, larger 

 D)  smaller, smaller 

 

8.  A psychologist studied three computer keyboard designs. Three samples of individuals were 

given material to type on a particular keyboard, and the number of errors committed by each 

participant was recorded.  The data are given below: 

Keyboard (Group) Mean # of errors  Std. dev. n 

A    1    1.72  5 

B    5    2.24  5 

C    6    1.87  5 

 

Are these data sufficient to conclude that there are significance differences in typing 

performances among the three keyboard designs? You have been asked to use one-way ANOVA 

technique to test this. Assume that data are three independent SRSs, one from each population 

and that the distribution of the errors committed is Normal. The partial ANOVA table is given 

below: 

Source of Variation df SS MS F 

Between Groups   35  

Within Groups  46   

Total     

 

a) Complete the ANOVA Table. 

 

b) State your null and alternative hypotheses 

H0: ______________________________________ 

H1: ______________________________________ 



 The Electronic Journal of Mathematics and Technology, Volume 9, Number 4, ISSN 1933-2823  

 

296 
 

 

c) What are the degrees of freedom of the F distribution: 

df (between groups) =   ________  df (within groups) = __________ 

  

d) Value of F-statistic:  ____________ 

 

 

e) p-value:  ________________ 

 

 

f) What is your conclusion at 0.05 significance level? Interpret in terms of differences 

among typing performances using three keyboard designs. 

 


